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AUTHOR’S NOTES
I’ve always had a passion for graphics and animation, both on film and in video
games.  I was moonlighting as a video production assistant in early 1984, when I
saw Apple Computer’s prophetic ad during the Superbowl.  The next week I
traded my life savings for a private studio called Macintosh.

Little did I know that someone would actually pay me to play with it.

After a year of consulting and another at Exxon, I landed my first all-Macintosh
job in 1986 developing a CAD/CAM system at Gibbs & Associates in L.A.  From
there I graduated to Claris in 1989 as an engineer on the FileMaker Pro database
team, and later the Claris Resolve spreadsheet team.  In 1992, I moved to Dayna
Communications in Salt Lake City where I met my wife Susan and daughter
Lauren.  We were married, ironically, on Independence Day and built a house
facing the Wasatch mountains.

Meanwhile, around 1985, I was busy creating a flashy little graphics engine that I
touted as the world’s first Animation Spreadsheet.  The user groups were
impressed with the wares of a self-taught programmer, but no one ever
suggested the concept would sell.

Fortunately, I had several derivative projects in the works– and pulling off The
Ultimate Poker Simulation seemed the most challenging of all.  Thus
PowerPOKER was born on a lonely November weekend way back in 1986.

Bringing a game this ambitious to market more than seven years later has been
an exercise in sacrifice and persistence, much like grooming a child to leave the
nest a virtuoso.  I studied a mountain of poker books and paid my share of “tax-
deductible research expenses” in Vegas, Reno and the California card clubs.
Three man-years of design and development time stole precious bandwidth from
my social life and even my career.

It wasn’t until 1991 that I decided to find a publisher for P o w e r P O K E R , and
naturally, my first choice was Electronic Arts.  They called me back the next day
with a most favorable review.  I was discouraged, however, to learn how
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undeserving Apple had made its own game market.  That is, had I put the same
effort into a business program or even a PC game, I might be a rich man.  But
then again, a Mac game was what I really wanted to do– and that’s what counts.
After a year’s hiatus, we found a wizard named Jerry Galloway to do a Windows
version, and the deal was done.

So more than 6,000 hours, 50,000 lines of Pascal, and four name changes later,
here it is! I’ve finally finished something on my own.  In fact, this is an unusually
productive year for me.  Not only have I shipped a great game, but I’ve adopted
Lauren and fathered baby Steven.  I’d say that’s a pretty good year.  

PowerPOKER is by no means perfect, but thanks to my family, my friends, and
the folks at Electronic Arts, it is close.

Was it worth it? You tell me…

Software is sculpture, and as such remains unfinished until the artist can sleep.

–Todd Ouzts
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SYSTEM

REQUIREMENTS
Copy Protection ♦♣♥♠

For your convenience, PowerPOKER is not copy-protected. The
author has dedicated many years of work to bring you this entertainment product.
Please support this continuing effort by honoring the license agreement. 

Hardware ♦♣♥♠

PowerPOKER requires at least an Apple® Macintosh® Plus
personal computer with 1 MB RAM, a hard disk, and a SuperDrive High Density
(1.44 MB ) floppy drive. To fully enjoy the game’s color animation, the minimum
recommended system is a Macintosh II with a color monitor. The faster the CPU,
the better.

Hard Disk Space ♦♣♥♠

A complete PowerPOKER installation occupies about 4.6 MB of
hard disk space. Some large modules are optional, such as the Movies (2 MB)
and Sounds (1.2 MB) folders. The Installer program on the enclosed floppy disks
may require as much as 9 MB of free hard disk space to complete the installation
process.
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System Software ♦♣♥♠

PowerPOKER requires at least System 6.0.5 to run, depending on
the options desired. The Dealer’s Speech option requires Sound Manager
(System 6.0.7 and higher). The Game Aliases feature and network play require
System 7.0 or higher.

To use the Movies folder for videotaped players, the QuickTime™
extension must be installed in your System Folder.

To enjoy synthesized Dealer’s Speech, Apple’s PlainTalk Text-To-
Speech extensions must be installed in your System Folder.

For best results with System 6 and a color monitor, make sure
the 32-Bit QuickDraw INIT is installed in your System Folder.

Memory Partition ♦♣♥♠

PowerPOKER requires at least 640K of memory to run on a
black-and-white screen. This is enough RAM to play on a 1MB Macintosh Plus
without MultiFinder. On color or grayscale monitors displaying 16 or 256 colors,
the program needs from 1 MB to 3 MB of RAM to function with all features. For
the best performance, we recommend running PowerPOKER with as few
extensions as possible.

I M P O R T A N T : Do n o t increase the number of
colors in the MONITORS control panel during
game play. 
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INSTALLATION
Before installing, check the System Requirements section, page 5 for configuration
information.

Instructions ♦♣♥♠

See the printed reference card included with this game.



GETTING STARTED
This chapter is designed to give you an overview of PowerPOKER’s basic
gameplay features. To learn about advanced features see the chapters that follow
(beginning with The File Menu, page 15).

QUICKSTART
If you’d rather play poker than read about playing poker, this section is for you.
The following walk-through will guide you through the basics and let you start
enjoying PowerPOKER right away. To learn more about the menus and features
described here, see the table of contents and index for page numbers. To get the
most out of PowerPOKER, we do recommend that you read the sections that
follow.

When you launch PowerPOKER, the Table Window appears, and 5-Card Stud is
ready to deal. You are Player 1, at the top of the screen.

1. Open the File menu and select OPEN GAME. Scroll down the list of game
names and double-click 5-CARD DRAW.

2. Click the deck or press ENTER or RETURN to begin. Each player antes,
and the dealer shuffles and deals five cards, all face down.
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3. When it’s your turn to bet, the dealer’s hand moves to you. Take a look
at the Action buttons at the top of the screen. The buttons with black
names are active; these are your current options. The buttons with dim
names are inactive (unavailable). Possible options are: CHECK (no bet),
CALL, BET, RAISE, and FOLD.

4. If you choose to CHECK, the bet passes to another player, or if you’re
the last bettor, the betting round ends. If you choose to BET, you must
specify an amount, either by typing a number (which appears in the field
under the CHECK button) or by clicking your chips. You can also choose
to RAISE the bet by specifying a higher amount than the previous bet
(but not higher than the maximum bet, displayed under the BET button).
If you choose to FOLD, your cards are returned to the deck (and are not
reused until the next deal), and the other players finish the hand. For the
purpose of this quickstart, stay in the game.

5. When the betting round is over, each player has the option to draw up to
five cards. When it’s your turn to draw, click the cards you wish to
discard (selected cards are highlighted in yellow), then click the DRAW
button (“DRAW” is now followed by the number of cards you
discarded). The cards you selected are replaced by new cards.

6. Now another betting round begins. When it’s your turn, choose a betting
option.

7. If the other players stay in the game, the hand ends in a showdown (all
players show their hands) and the winner takes the pot.

Now you know the basics. Enjoy!

THE MENU BAR
The Menu Bar contains a number of menus and submenus which offer options to
help you get the most out of PowerPOKER. Menu items followed by ellipses (…)
open dialog boxes, and menu names followed by arrows display submenus. For
descriptions of each menu, see the table of contents under the menu name.
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• To select a menu item: Click the menu name and hold down the mouse
button as you drag the cursor to the desired menu item, then release the
mouse button.

• To select items from submenus: Select the menu item as described
above (a submenu appears) then drag the cursor to the desired
submenu item and release the mouse button.

• To return to the factory settings in a dialog box, click DEFAULTS .

• To abandon your changes and return to the previous settings, click
CANCEL.

TABLE WINDOW
All the action takes place in the Table Window. This window opens automatically
when you launch the program and remains open until you quit. 

The Table Window
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☞ The width of the Table Window is determined by the maximum number
of cards that a player may have in his hand (i.e., 2-Card Poker vs. 8-Card
Stud).

☞ The height of the Table Window depends on the number of players, or
seats, at the table. You can set this using the Table option (see The
Options Menu, page 58).

Title Bar ♦♣♥♠

The Title Bar displays the name of the current poker game. 

Like most Macintosh windows, you can move the Table Window by dragging the
Title Bar. Clicking the Close box quits the game.

Action Buttons ♦♣♥♠

Below the title bar are the six Action buttons you can use to play your hand.

For complete descriptions of these functions, see the Action Menu section, page
48.

Status Area ♦♣♥♠

The status area is just below the Action buttons. There are several status displays
to keep you informed.

Betting field (type amount here)

The Betting field activates when it’s your turn to place a bet or raise, and allows
you to type the amount of your bet (an alternative to clicking directly on your
chips).

Close Box



The Min and Max displays show the current minimum and maximum betting
limits. Depending on the house rules, these limits may change in each betting
round or even after each bet (see Betting Limits, page 28, for more information).

The Pot displays the number of chips currently in the pot. This number increases
as players bet and raise during each betting round.

The Message area displays a play-by-play description of the action, prompts  you
when it’s your turn to make a decision, and tells you when PowerPOKER is in
pause mode. 

The last display is simply a digital clock (displaying system time), because time
flies when you’re having fun!

Playing Surface ♦♣♥♠

The Table Window is designed in rows and columns. Each player occupies a
single row across the Table Window. From left to right, you’ll see the player’s face,
the chip rack, the betting area, the deck area and finally the cards making up the
player’s hand.

In a real poker game, the action progresses in a clockwise direction around the
table. In PowerPOKER, the action flows from top to bottom. The deck travels
vertically to the next dealer after each game.

The Player Monitor ♦♣♥♠

Each player at the table is represented by a unique face inside a TV-like screen
called a player monitor. If you’re using the QuickTime option, this is where the
“movies” appear. Each player monitor contains a number indicating the player’s
position at the table (1-10). Your player monitor is indicated by a thick outline and
displays your percentage chance (historically) of winning based on your hand.

In a one-player game, you are Player #1, the first seat at the top of the Table
Window. This way, your chips and cards are kept close to the menu bar and
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Action buttons. If you join another table as a network guest, the host assigns
another seat for you on a first-come, first-served basis.

ASSUMING AN IDENTITY
Before the first deal or between games, you can choose to assume a different
identity. In doing so, you also inherit the player’s stake by exchanging the chips in
your racks. This option is not available during network play.

To move another player to your seat:

To cancel the action before step 3, move the hand cursor outside the dotted
outlines and release the mouse button.

SEATING ASSIGNMENTS
You can change the seating arrangement of your computer opponents using the
method described under Assuming an Identity. During a network game, players
cannot be moved.

NOTE: You may not move a player while cards are on the
table.

Manipulating Your Hand ♦♣♥♠

There are a number of actions you can perform directly on your cards with a click
of the mouse, from peeking at them, to selecting them, to sorting them. For more
information on selecting and sorting cards, see The Action Menu, page 48. For
more on peeking at cards, see The Options Menu, page 58.
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PEEKING AND SORTING
If PEEK AT MY HAND is not checked in the Options menu, your hole cards (cards
dealt face-down) remain face-down throughout the hand to remind you that the
other players can’t see them. You can take a quick look at them anytime. Also,
you can quickly sort your cards to get an idea of your best poker hand rank.

• Place the cursor on any face-down card, then click and hold the mouse
button. 

Your hole cards elevate from the table and flip face-up (cards dealt face-up
remain flat on the table). Your hand is sorted according to its best poker hand
rank. A written description of your hand appears over your chip rack (in a thought
balloon, indicating that only you know your true hand). Your cards remain face-
up and sorted until you release the mouse button. 

TIP: If you click on a card that was dealt face-up, only the
visible cards in your hand are sorted and evaluated, and
your hand description appears in a box (indicating that
your opponents know the value of your visible cards).

NOTE: To keep your entire hand face-up all the time, check
PEEK AT MY HAND in the Options menu.

SELECTING
Some games require you to draw, discard, pass, or roll cards in your hand. When
this occurs, you must select the cards you wish to replace, throw away, pass to
another player, or turn face-up for other players to see. You can also de-select
cards.

• To select cards, place the cursor over a card and click the mouse button.
The card becomes highlighted (yellow).

• To de-select cards, place the cursor on a highlighted card and click the
mouse button.
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THE FILE MENU
Use the File menu to play PowerPOKER over a network, to open and save game
files, and to print or close windows.

Network ♦♣♥♠

Use the Network submenu to play poker with other people over an AppleTalk
network. For instructions, see the Network section, page 18.

Open Game… ( -O) ♦♣♥♠

To play or edit a poker game, a game file must be open. The first time you launch
PowerPOKER, 5-Card Stud is opened automatically, ready to deal. From then on,
PowerPOKER automatically reopens the last game you played. The title bar of the
Table Window displays the name of the current game. Only one game file can be
open at a time. 

To open a game:

1. Choose OPEN GAME from the File menu. A list of available games
appears.

2. Double-click the name of the game you wish to play. If you’ve changed
the rules of the current game, click OK to save the game file, or CANCEL
to abandon your changes.
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NOTE: If you’re running System 7 or higher, some file
names are italicized. These are called aliases. Many poker
games are known by more than one name, so we’ve
included aliases for additional names. For more information
on aliases, see The Rules Menu, page 21.

Creating a New Game
To create a new game, open an existing game file whose rules are similar to the
one you have in mind (follow the instructions under Open Game, page 15), then
modify its game rules using the options in the Set Game Rules submenu (see The
Rules Menu, page 21). Use the SAVE GAME RULES AS… option to save your new
game under a new name (see below).

Save Game Rules ♦♣♥♠

This command is enabled only when you have modified the current game rules
(using the Set Game Rules menu) without saving them. SAVE GAME RULES
replaces only the game rules in the file with your changes. 

To save game rules:

1. Select SAVE GAME RULES from the File menu.

2. Click OK to save, or CANCEL to revert to the previously saved rules.

A game file also contains a statistical database that is updated while each hand is
played. This information is automatically saved when a game file is closed, unless
the file or disk is locked.

NOTE: To keep the original rules and save your rules under
a new name, see Save Game Rules As… below.

Save Game Rules As… ♦♣♥♠

This command is enabled whenever a game is open. Adjust the rules to your
preference, then select SAVE GAME RULES AS… to create a new game file by
saving the game under a unique name.

To create a new game file:

1. Select SAVE GAME RULES AS… from the Rules menu. The save dialog
box appears with the Games folder open.



2. Type in a new name for your game, then click SAVE.

When you click SAVE, the game asks whether you want to save existing statistics
as well. If you have modified, or plan to modify any rules that would affect the
relative strengths of poker hands during the course of play, we recommend that
you Reset Hand Strengths, forcing your computer opponents to spend the first 10
hands learning the new rules. Once saved, the new file becomes the currently
open game, and its new name appears in the title bar.

Revert To Saved Game Rules ♦♣♥♠

This command is enabled when there is an open game and you have modified its
rules without saving them. Select REVERT TO SAVED GAME RULES to restore the
game’s original rules from the time they were last saved to disk. The game file’s
statistical data is not affected by this command.

Page Setup… ♦♣♥♠

This command allows you to set the printing options, using the System’s PAGE
SETUP dialog box for your chosen printer. If you’re using a LaserWriter® and
want to print the Table Window, we recommend that you turn Graphics
Smoothing OFF, then click the Options button and turn Precision Bitmap
Alignment ON. PowerPOKER stores this information in the House Rules file.

Print… ♦♣♥♠

This command allows you to print the active window, using the System’s PRINT
dialog box for your chosen printer. If you’re using a LaserWriter and you want to
print a color window, we recommend using the Color/Grayscale option.

Quit ( -Q) ♦♣♥♠

• To quit PowerPOKER, select QUIT from the File menu, click the Table
Window’s CLOSE box, or press -Q. 

The house rules, options, and standings are automatically saved to disk. If you
have made changes to the current game’s rules, you’ll be asked if you want to
save those changes before quitting (see Save Game Rules and Save Game Rules
As…, page 16).
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NETWORK
When you select NETWORK from the File menu, a submenu appears to the right.
Use the Network submenu to play poker with other people over an AppleTalk™ or
Ethertalk network. 

You become a network guest by linking to another poker game via the Join
Another Table menu command. A copy of PowerPOKER becomes a network host
when someone else links to it. All network players must have an original copy of
PowerPOKER.

SYSTEM REQUIREMENTS FOR NETWORK PLAY:

System 7 (or higher) and the Apple® Event Manager  (included with System 7)
are required for network play. Up to 10 human players can be connected via
LocalTalk cables, EtherTalk and/or Apple Remote Access modem connections.

HOSTING A GAME
The host controls all the action by sending and receiving AppleEvent messages to
and from its guests. During a network game, only the host can officially pause
and resume the action. Action may pause while a network player contemplates
the next move; this is indicated by a white cursor on the host’s screen.

In order to host a game, Program Linking must be turned ON in the host
Macintosh’s SHARING SETUP control panel. In addition, the host Macintosh
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must either allow guest access, or have user accounts (allowing program linking)
set up for each player. Use the System’s USERS & GROUPS control panel to set
up these access privileges (for more information, see your Macintosh manual). Be
sure to select games that all network guests have.

Invite Other Players ♦♣♥♠

When this menu item is checked, other people can connect to your table as guests
(if you are not already a guest yourself). If you prefer a private game, turn the
feature off to disallow connection attempts. You may still join another table if you
wish.

Join Another Table… ♦♣♥♠

Use this command to link to a copy of PowerPOKER running on another
Macintosh. You may only join a game between deals (never during a game).

Program Linking Dialog

To join another table:

1. Select JOIN ANOTHER TABLE… from the NETWORK submenu (in the
File menu). The Program Linking dialog box appears.

2. From the MACINTOSHES list on the left, click the name of a Macintosh
you wish to link to. If a PowerPOKER is running on the selected
Macintosh, the available table appears under POKER TABLES.
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3. Click the table you wish to join, then click OK.

NOTE: When you join a network game, the host’s House
Rules file is copied to your computer, replacing your own
House Rules file. If you have customized your House Rules,
and wish to keep them, we recommend moving or
renaming your House Rules file before joining a network
game.

Send Message… ♦♣♥♠

Use this command to type and send short messages to all active network players
(at your current table).

Send Message Window

To send a message:

1. Select SEND MESSAGE… from the File menu.

2. Type your message in the text window, then click OK to send, or CANCEL
to abort the message.

End Session ♦♣♥♠

Use this command to disconnect from other network players. Do not terminate
your session by shutting down or restarting your Macintosh.

NOTE: If you are a guest and your session is terminated
while a game is in progress, you must quit PowerPOKER
and relaunch the program.
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THE EDIT MENU
The edit menu contains standard Macintosh cut-copy-and-paste features. These
commands are available when the active window contains an editable text field. In
addition to editing features, PowerPOKER’s dialog boxes can perform simple
mathematical calculations.

THE RULES MENU
There are two distinct classes of rules in PowerPOKER:

☞ House rules apply to all games during a poker-playing session. These
rules are stored in the House Rules file, inside the Options subfolder. 

☞ Game rules cover only the current poker game and are stored in the
game file.

When a conflict arises, game rules generally override the house rules. Some
game rules may even override other rules in the same game.
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NOTE: When you join a network game, the host’s House
Rules file is copied to your computer, replacing your own
House Rules file. If you have customized your House Rules,
and wish to keep them, we recommend moving or
renaming your House Rules file before joining a network
game.

Show House Rules ( -J) ♦♣♥♠

This command opens the House Rules text window. You can leave this window
open for reference during game play.

The text usually describes the house rules currently in effect. If you change the
house rules while a game is in progress, the House Rules window displays your
changes, but the old house rules remain in effect until the next deal. You can
change the house rules with the commands in the Rules menu.

NOTE: To return all the house rules and options to their
default values, quit to the Finder and throw the House
Rules file (located in the OPTIONS subfolder) into the
Trash. The next time you launch PowerPOKER, the House
Rules file will be recreated with the factory settings.
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Show Game Rules ( -G) ♦♣♥♠

This command opens the Game Rules text window, or brings it to the front if it’s
already open. You can leave this window open for reference during game play. It
is updated whenever a new game is opened.

The text describes the game rules currently in effect. If you change the game rules
while a game is in progress, the Game Rules window displays your changes, but
the old game rules remain in effect until the next deal. You can change the game
rules using the expert commands in the Set Game Rules submenu (see page 29).

Customs… ♦♣♥♠

The Customs dialog box defines some general rules that affect all games played
during a session. Some of these rules may be overridden by the game rules when
necessary.



Generally, games with few betting rounds (such as 5-Card Draw) require
everyone to ante before the deal to get the pot started. Games with many betting
rounds (such as 7-Card Stud) usually forego the ante for a faster deal. (For more
information, see Ante, page 32.)

A Choose who antes (everyone, dealer only, dealer for each player) based
on the type of game being played (open or closed poker).

☞ Closed poker is any game in which all cards are kept face-down
until the showdown, as in draw poker.

☞ Open poker is any game in which one or more cards are dealt face-
up for all players to see, as in stud poker.

B Check and raise is allowed. Check and raise is the practice of checking
and then raising someone else’s bet in the same betting round. When
permitted, this is considered a deceptive tactic.

C Fewest wild cards win. When a game uses wild cards and two or more
hands tie in the showdown, you can rule that the hand with the fewest
wild cards (or the most natural cards) wins.

D Check this box to rule that every hand in the showdown must be
exposed. (Otherwise, some of your wily opponents may choose not to
show their losing hands.)

24
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Chips… ♦♣♥♠

The Chips dialog box determines the denominations and colors of the four stacks
of chips in each player’s rack. The value of the top stack of chips is the base unit,
or ante value. The second stack of chips is usually the same denomination so that
there are plenty of these chips on the table.

The list on the left contains some common value and color combinations. Select a
set in the list and click the Preset button to change the values in the pop-up
menus on the right. (You can also double-click the desired set to select it.)

You can customize values and colors independently using the pop-up menus on
the right. Custom chip denominations must be in ascending order, and in even
multiples (e.g.: 5, 10, 20, 100 are even multiples; 5, 10, 25, 100 are not). Note
that chips of different colors don’t necessarily have different values, and chips of
the same color are not necessarily the same denomination. In a Network game,
your red chips may be $25 chips, while an opponents may be $10 or $100 chips.

Color changes take effect immediately, but value changes take effect when the
next game is dealt.
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Stakes… ♦♣♥♠

This dialog box determines the rules players must follow when buying in at the
beginning of the session, or buying additional chips during the session.

A To start a session off, and when buying more chips, you must buy in for
the amount shown. Type in the desired buy-in amount.

B Choose whether stakes are referred to as “chips” or “dollars.” When the
stakes are referred to as currency, chip values are displayed with dollar
signs ($) and the dealer’s voice announces values as “dollars.”

C Click this button for a casual game (players can buy chips anytime).

D Click this button to play for table stakes (players may buy chips between
games only). 

E Click this button to play a freezeout game. Freezeout is like playing in a
professional tournament. When you run out of chips, you’re out of the
competition. The player who wins all the chips wins the tournament.

NOTE: When playing table stakes or freezeout in real poker,
if you run out of chips during a game, a side pot is created
and you can only win the amount in the main pot at the
time you tap out (run out of chips). PowerPOKER does not
support side pots.

A B

C

D

E
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Raise Limits… ♦♣♥♠

This option lets you determine how many times players may raise the bet during
each betting round. 

A Click this button to set the maximum number of raises permitted in each
betting round by all players. Type the desired limit in the text field.

B Click this button to set the maximum number of times each player may
raise during the round. Type the desired limit in the text field.

C Click this button to allow an unlimited number of raises by any player at
any time.

D Check this box to allow unlimited raises whenever two players are left to
compete for the pot head-to-head.

A

B

C

D
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Betting Limits… ♦♣♥♠

This option lets you determine minimum and maximum betting limits for this
session. 

There are many systems to determine the minimum and maximum betting limits
in each round of a game. PowerPOKER supports several:

A The most popular is the fixed limit, where the minimum and maximum
bets remain the same throughout the game. As a variation, you can
specify that either limit graduates (increments) or doubles in each
successive betting round.

B Check this box to override the minimum bet and require players to bet
the raise after a betting round is opened. The minimum bet becomes the
amount any previous player has put in the pot at one time.

C Click this button to set a maximum bet or raise. Specify fixed, graduated,
or doubled (in each round).

D When a fixed, graduated or doubled maximum bet is set, check these
boxes to additionally double the limit in the final betting round, and/or on
any open pair (when any hand with at least a pair is showing).

E Click this button to use a variable system for the maximum bet. Set a
doubling limit (players can raise up to the amount of the previous bet), a
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half-pot limit (half the amount currently in the pot), or a pot limit (the
amount currently in the pot). No limit means that you can bet or raise by
as much as the REBUY rule (in the Stakes dialog box) allows.

F Check this box to set a Maximum Ceiling that overrides all of these
limits, so that no single bet or raise can ever exceed a practical fixed
amount. Type the desired “ceiling” amount in the text field. (This is
highly recommended.)

SET GAME RULES
The Set Game Rules submenu allows you to change the rules of the currently
open game. You can create variations of existing games or design entirely new
games using the expert features under this menu.
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◆ A diamond in one of these menu items indicates that changes have been
made to rules in that dialog box.

Remember to save the game file under a unique name if you want to keep the
changes. You can change game rules while the game is in progress, but your
changes won’t take effect until the next deal.

TIP: After changing game rules, reset the Hand Strengths
information so your computer opponents l e a r n the new
rules from scratch.

Description… ♦♣♥♠

Sometimes a well-written description is more understandable than a list of terse
rules. This is a freeform description of the game that will appear near the top of
the Game Rules text window. 

You can use it to answer questions like:

✔ How did the game get its name?

✔ What poker family does it belong to?

✔ What type of game is it?

✔ What other game is it based on?

✔ What makes it unique or interesting?
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Then include some tips for how to play the game and win.

To create a description:

1. Select DESCRIPTION from the SET GAME RULES… submenu . 

2. In the text field, type a description of your poker game. Click OK to return
to the game.

Aliases… ♦♣♥♠

Many games are known by multiple names, or aliases. Sometimes it depends on
what part the country you’re in, from Texas Hold ‘em to California Lowball to New
York Stud. There’s even Australian Poker and English Poker. 

Alias objects are not game files, only alternative names for the same game.

To create a game alias:

1. Select ALIASES from the  SET GAME RULES… submenu 

2. Type alternate names in the text field, then click CREATE ALIAS FILES.
Your aliases appear in the list of games in the Open Game dialog box.

NOTE: The Create Alias Files button is disabled on pre-7.0
systems.
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Ante… ♦♣♥♠

This dialog box lets you determine whether there is an ante before the deal, and if
so, how much.

A Check this box to rule that players must ante before the deal. Specify the
required ante amount.

B Check this box to rule that each player must ante. This setting overrules
any you may have set in the Customs dialog box (see Customs, page 23).

TIP: The house rules usually state who must ante. In games
like Jackpots however, each player should always ante
because the deal could be passed out. It wouldn’t be fair for
only one player to jack the pot before a redeal.

A

B



Deal Script… ♦♣♥♠

The Deal Script lets you customize the deal by editing a list of procedures. Use it
to alter an existing game, or to create an entirely new one.

The Dealer’s Procedures list shows all the possible steps supported by
PowerPOKER (a list of these procedures, along with their descriptions, appears
on page 35). A number sign (#) in a procedure name indicates that the number of
cards is required as a parameter (e.g., in the procedure deal # face down, you
must type into the text field the number of cards you wish dealt face down). The
Deal Script list controls the deal while the game is being played. The next deal
proceeds according to this list, in order from top to bottom.

To edit the deal script, use the APPEND, REPLACE, INSERT and DELETE buttons
as described in the following instructions.

NOTE: When a procedure requires the number of cards, be
sure to set the # of Cards field before clicking A P P E N D,
REPLACE or INSERT.

APPEND
Use APPEND to add a procedure to the end of the script.

1. Select a procedure from the Dealer’s Procedures list. Type a number in
the text field, if applicable. 
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2. Click APPEND. The selected procedure appears at the end of the Deal
Script.

REPLACE
Use REPLACE to quickly remove an existing procedure from the Deal Script and
insert another procedure in its place (i.e., the new procedure appears in the same
position in the Deal Script list).

1. Select from the Deal Script the procedure you wish to delete.

2. Select from the Dealer’s Procedure list the procedure you want insert
into the Deal Script. Type a number in the text field, if applicable. 

3. Click REPLACE. The old procedure is replaced by the new procedure in
the Deal Script.

INSERT
Use INSERT to insert a procedure between two procedures already in place.

1. Select from the Dealer’s Procedures list the procedure you wish to insert
into the Deal Script. Type a number in the text field, if applicable. 

2. Select from the Deal Script the procedure you wish your new procedure
to appear before. For example, if your list reads: 

deal 1 face down
betting round
deal 1 face up 

and you want to place the new procedure before (above) deal 1 face up,
select deal 1 face up now.

3. Click INSERT.

DELETE/DELETE ALL
Use these buttons to delete from the Deal Script a single procedure or all
procedures.

• To delete one procedure, select the procedure you wish to delete, and
click DELETE.

• To delete the entire Deal Script, select DELETE ALL.
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PowerPOKER supports the following procedures:

Deal # face down Deal a number of cards face-down to each active
player.

Deal # face up Deal a number of cards face-up to each active
player.

Deal # down to widow Deal a number of cards face-down to a hand to be
shared by all active players.

Deal # up to widow Deal a number of cards face-up to a hand to be
shared by all active players.

Roll any # Each active player turns a number of face-down
cards over for all to see.

Roll next widow card Expose the next face-down card in the shared
hand.

Betting round Interrupt the deal for a betting interval, until all
bets are equalized. If only one player remains, the
game is over.

Draw up to # Each active player may replace up to a number of
cards with newly dealt ones, or may stand pat
(not replace any).

Pass # to the left Each active player must pass a number of cards
to the player on the left.

Pass # to the right Each active player must pass a number of cards
to the player on the right.

Discard any # Each active player must discard a number of
cards.

Arrange strategically Each active player may sort his hand in an order
designed to surprise his opponents as each card
is exposed one at a time.

Flip next arranged card Each active player exposes his next face-down
card, after all hands have been arranged
strategically.
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Blind & Straddle… ♦♣♥♠

A Click this button to allow checking in the first betting round.

B Click this button to rule that the worst hand must open. Specify the
required opening bet.

NOTE: In a game played for high, the worst hand is the
lowest hand. When each player shows only one card,
ties for the worst card are broken by the alphabetical
order of suits (♣ clubs, ♦ diamonds, ♥ hearts, ♠
spades). So if one hand shows ♥2 and another shows
♣2, the deuce of clubs must bet first.

C Click this button to rule that the blind (first hand) must open. Specify the
required opening bet. 

D Check this box to rule that the second hand must straddle (raise the bet
by a specified amount). Specify the required raise (usually double the
previous bet).

E For remaining betting rounds, choose to play pass and out (checking is
not allowed), or pass and back in(checking is allowed).

A
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Jokers… ♦♣♥♠

This dialog box lets you determine whether to include jokers in the deck before
the shuffle, and if so, how the joker will be dealt or played during the game. 

A Choose whether to include one or two jokers, or none at all.

B Check this box to deal the joker first, especially in a game using a widow
(as in the game Kankakee).

C Click this button if the joker is fully wild, and may be used in place of any
missing card to create a potential winning hand.

D Click this button if the joker will be used as the bug (valid as an ace or a
wild card to fill a straight or flush only).

Fixed Wild Cards… ♦♣♥♠

This dialog box allows the designation of wild cards that are fixed throughout the
game.

A
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D
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A
B

A Click on any card to select or de-select it. Selected cards are fully wild in
each player’s hand.

B The Common Wilds checkboxes provide some shortcuts for defining
fixed wild cards. Check these boxes as an alternative to selecting cards.

★ When dealt, wild cards are marked with a lucky star in the upper right
corner.

Variable Wild Cards… ♦♣♥♠

This dialog box allow you to designate wild cards that are unknown at the deal
and may change during a game. When a variable wild card changes, the old wild
rank is canceled. This means the strength of your hand may change drastically
before the showdown. Ranks that become wild on your third card may not stay
wild on the seventh card. On the other hand, your last card might suddenly give
you a winning hand.
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A When you check this box, the first card you roll (turn face up) and every
other card of the same rank is wild (in your hand only).

B When you check this box, the lowest (or only) card in the hole (dealt face
down) and every other card of the same rank is wild (in your hand only).
You can make the highest hole card wild instead.

C When you check this box, the lowest card exposed in the widow and
every other card of the same rank is wild for everyone. You can choose
either the first, last, highest or lowest exposed card.

D When you check this box, the rank of the only exposed widow card is
wild for everyone, but the card is not counted as part of any player’s
hand. It merely marks the rank of wild cards.

Action Card 1… & Action Card 2… ♦♣♥♠

Many games in the Baseball family make use of Action Cards™. Generally, when a
card of a particular rank is dealt face up, the deal pauses while the card’s recipient
performs some special action, such as paying a specified amount into the pot or
receiving an extra card. A game may have up to two Action Cards.
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A Check this box to activate Action Cards, then specify the rank of the
Action Card (A, 2, 3, etc.). The remaining options in this dialog box allow
you to determine what action a player must take when this card is dealt.

B Click this box to invoke the match the pot or drop rule; when the Action
Card is dealt face-up, the recipient must bet the amount currently in the
pot, or fold. (e.g., in the game Baseball, when you are dealt a face-up
three you must match the pot or drop.)

C Click this box to set a fixed limit when matching the pot. (The Maximum
Bet Ceiling does not apply to action cards.)

D Click this button to rule that the recipient must pay a fixed amount or drop.

E Click this button to rule that the recipient of the Action Card must pay a
multiple of the pot amount (or drop). Specify the multiple by typing a
number in the text field.

F Click this button to rule that when the Action Card is dealt, an additional
card is dealt to the recipient. Specify whether the free card should be
dealt face-up, or face-down.

Power Cards… ♦♣♥♠

Some games make use of a Power Card™ that guarantee you’ll win half the pot in
the showdown, regardless of the high or low poker hand you otherwise hold. The
Power Card holder gets half the pot before it is split among other players. If there
is no Power Card in the showdown, the rule is ignored and the pot is claimed as
specified in the Showdown dialog box (see page 44).
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A Click this button to disable the Power Card option.

B Click this button to rule that the Power Card be the highest or lowest card
of a particular suit. Specify highest or lowest, and which suit.

C Click this button to rule that the Power Card be the highest or lowest hole
card (face-down card) of a particular suit. Specify highest or lowest, and
which suit.

D Click this button to designate any single card as the Power Card. Specify
rank and suit.

Opening Requirements… ♦♣♥♠

This dialog box determines the hand strength required to open the pot by betting
first. In most games, any hand can open.



A Check this box to rule that a player must have a pair of a particular rank
to open the pot. Specify the rank. Checking this box activates the
additional options in this dialog box.

B Check this box to rule that a four-flush may open also.

C Check this box to allow a bobtail (a four-flush or a four-straight) to
open. This increases the chances of making straights and flushes.

D If no player holds a qualifying hand, the deal is usually passed out (i.e.,
the pot stays unclaimed and all cards are gathered). Specify whether to
play again with the same opening requirements, or adjust the
requirements up to aces or two pairs (or better).

E In the event that the second deal produces no qualifying hand, specify
whether to pass the deal out and play again with the original
requirement, or keep the current hand and allow any player to open.

F Check this box to rule that the deal will pass to the next active player
each time it is passed out. If this box is not checked, the deal stays with
the first dealer until the final showdown.

G Check this box to rule that players must ante again after the deal is
passed out (according to the settings in the Ante dialog box and house
rules Customs dialog box). If unchecked, players don’t ante when the
deal is passed out.
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Legal Hands… ♦♣♥♠

In poker, there are standard hands and special hands. Depending on the rules, a
game may accept only one sort or the other, or both. Use the Legal Hands dialog
box to define the game’s playable hands, and to help you recognize any poker
hand when you make one. 

The list on the left shows all possible hands supported and evaluated by
PowerPOKER, ranked in ascending order. 

A To change the playable hands, click on a hand name to select (highlight)
or de-select it. To see definitions and examples of any hand, pass the
cursor over a poker hand in the list. 

B To select only the standard poker hands, click DEFAULTS. 

C Use this pop-up menu to specify the value of Aces in your game. The
highest and lowest possible hands may depend on how aces are used in
the game.

A
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Showdown… ♦♣♥♠

Use this dialog box to determine which hand wins the pot, and the requirements
for winning hands.

A Click this button to play for the highest hand. Most games are played for
high.

B Click this button to play for low.

C Click this button to play high-low; the pot is split between the best high
hand and the best low hand. In PowerPOKER, the cards speak for
themselves (i.e., you don’t have to declare whether you’re going high or
low — the cards determine the winner).

NOTE: When two or more players tie a high or low
game, the pot splits evenly among them. In rare high-
low games where two players tie, the pot splits
between the first high winner and the first low winner.

D Choose whether Aces are used high, low, or both. Normally, Aces may be
used high (above the king) or low (below the deuce) at the holder’s
option. 
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E Check this box to rule that straights and flushes swing. When they do,
they can be used as low hands even though they are also strong high
hands (an important distinction in a low or high-low game).

F Check this box to rule that a flush containing one or more wild cards can
be evaluated as a double- or even triple-ace flush (beating a standard
ace-high flush). Normally, wild cards may not represent cards you
already have in your hand. 

G Check this box to limit the number of cards each player may “borrow”
from the widow. Specify the number of cards which may be used.
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THE DEAL MENU
This menu controls the flow of action between deals and determines who chooses
the next game to play. It also lets you launch frequently-played games from a
Favorite Games list at the bottom of the menu.

Play / Pause ( -P) ♦♣♥♠

This feature lets you pause the game and resume play at your leisure.

• To pause the game (or resume play from pause mode), press -P,
ENTER or RETURN, or click the deck.

N O T E : Unless Dealer’s Choice is checked, the action
pauses after each deal. When Dealer’s Choice is checked,
the action is paused between games only when it’s your
turn to deal.
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Play in Background ♦♣♥♠

Normally the action stops when you open another window or bring another
application to the foreground. When PLAY IN BACKGROUND is checked, however,
PowerPOKER continues playing even if the Table Window is not the active, front-
most window. 

Dealer’s Choice ♦♣♥♠

Normally the current game is dealt again and again until you open a new game
before the deal. When DEALER’S CHOICE is checked, the current dealer chooses
the next game. (DEALER’S CHOICE is not available during net play.)

When a computer player is the dealer, a game is chosen automatically before the
deal. If you are the current dealer, you may either select Open Game from the File
menu, or select one from the Favorite Games list in the Deal menu.

Favorites Only ♦♣♥♠

FAVORITES ONLY is enabled only when DEALER’S CHOICE is checked. When
both items are checked, a computer dealer will choose a game at random from the
Favorite Games List, rather than from the current game folder. This feature allows
you to easily restrict the games you want to play during a session.

(Favorite Games List) ♦♣♥♠

The last section of the Deal menu is the Favorite Games list. It can contain up to
10 games which are sorted in the order the games were last opened or played.
The current game appears at the top of the list, marked with a check mark. 

• To create a list of your favorite games for easy access, use the OPEN
GAME option (in the File menu) to add each game to the Favorite Games
list individually.

• To delete a game from the Favorite Games List, press and hold the
OPTION key, then highlight the name of the game you want to delete and
release the mouse button.

As with all house rules and options, PowerPOKER remembers the Favorite Games
list by saving it in the House Rules file when you quit.
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THE ACTION MENU
The first six items in the Action menu are enabled whenever you are required to
make a choice during a game. These commands can be executed using the
command keys to the right of each menu item, as well as by clicking the six
corresponding Action buttons across the top of the Table Window.

The button names sometimes change to better describe their function (e.g., BET
becomes BET 3, DRAW becomes DRAW 2).

TIP: As a shortcut, press ENTER or RETURN to choose the
default option. When the FOLD button is enabled, you can
also press ESC or CLEAR to fold your hand.

Check ( -K) ♦♣♥♠

When the game rules allow, and no bet has been made by a previous player in the
current betting round, you can choose to check (pass without betting). For more
information on game rules affecting this command, see Set Game Rules, page 29.
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Betting Area Minimum Bet Maximum Bet Amount in Pot

Call ( -C) ♦♣♥♠

When you think you hold a competitive hand and you want to see (match) another
player’s bet without raising it, you should call.

• Click CALL or press ENTER or RETURN to place a matching bet. (Any
partial bet you began manually — by clicking your chips — is completed
automatically, even if you tossed out too many chips or you need
change.)

Bet ( -B) ♦♣♥♠

Whenever you have the privilege of opening a betting round, or any previous
players have checked to you, you can place a bet. (If you don’t want to open, you
should check.)

To place a bet:

1. Indicate the amount you wish to bet (click the appropriate chips in your
rack, or type the desired number into the text field).

2. The Bet button’s title changes to reflect the amount you’ve thrown into
the pot so far. When it looks right, click BET or press ENTER or RETURN
to confirm.

If you bet more than the current maximum betting limits allow, any excess chips
are returned to your chip rack.

N O T E : You may not bet less than the minimum bet
displayed at the top of the screen. If you specify an amount
lower than the minimum and confirm your bet, the game
will default to the minimum bet.



50

Descriptive
Message

Special Action
button

Prompt

Hand
(sorted)

Raise ( -R) ♦♣♥♠

When you bet more than the previous bet (and the game or house rules allow),
you raise the bet. The RAISE option is enabled only when you have bet an amount
larger than that required to call. When this occurs, pressing ENTER or RETURN
raises the bet.

Draw, Roll, Pass, Discard, Arrange ( -D) ♦♣♥♠

The fifth menu item (and action button) is a Special Action command that is
enabled by certain dealing procedures. The title and function changes according to
the rules of the current game.

When one of these actions is required, a prompt in the message area at the top of
the Table Window tells you what the rules require you to do (the dealer’s voice
may also state the rule). Your cards are sorted according to your best poker hand
rank and flipped face up for you to see. A message describing your hand appears
over your chip rack (the other players can’t “see” your hand).

To perform a Special Action:

1. When prompted, click on the desired cards in your hand to select them.
If HELP ME SELECT CARDS is checked in the Options menu, some cards
may be preselected (highlighted) for you. 

• To de-select highlighted cards, click them.

2. To accept your selections, click the Special Action button, or press
ENTER or RETURN.
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SPECIAL ACTIONS
Draw Replace up to a specified number of cards in your hand with new cards

from the deck. The button’s title changes to confirm your selection
(e.g., DRAW 3). If you want to keep your hand “as is”, you may stand
pat by declining to replace any cards (de-select any selected cards and
click NO DRAW).

Roll Turn a specified number of cards face-up. The button’s title changes to
indicate the number of cards to roll (e.g., ROLL 1). The option is
disabled until you select the correct number of cards.

Pass Pass a specified number of cards to another player (left or right). The
button’s title changes to indicate the number of cards to pass (e.g.,
PASS 3). The option is disabled until you select the correct number of
cards. Your selected cards are moved to the next player’s hand and are
replaced by the same number of cards from previous player’s hand .

Discard Throw away a specified number of cards. The button’s title changes to
indicate the number of cards to discard (e.g., DISCARD 2). The option
is disabled until you select the correct number of cards. Your selected
cards are returned to the bottom of the deck and can no longer be used
in any player’s hand.

Arrange Strategically arrange your cards. When the game rules allow (as in
Anaconda), this option lets you sort your hole cards in a strategic
manner, so that as each card is flipped over, your opponents are kept
guessing as to the value of your hand until the end of the game.

• To arrange your hand, click on any card and drag it to a new position.
When your cards in the desired positions, click ARRANGE. (Once
arranged, your cards cannot be rearranged.)

Fold ( -F) ♦♣♥♠

Use the FOLD command when you think you have no chance of winning the pot, or
you don’t want to call a large bet or raise. Your cards are returned to the bottom of
the deck and are not reused in the same game. Any chips you have bet are
forfeited to the pot for someone else to win.
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NOTE: In some games the deal can be passed out . In this
event, folding eliminates you from the game until after the
final showdown. (For more information, see O p e n i n g
Requirements, page xxx.)

Minimum Bet ( -N) ♦♣♥♠

Use this shortcut as an alternative to clicking your chips or typing in the minimum
bet amount.

• To automatically place the minimum bet, select MINIMUM BET ( -N),
then click BET or press ENTER or RETURN.

Maximum Bet ( -M) ♦♣♥♠

Use this shortcut as an alternative to clicking your chips or typing in the maximum
bet amount.

• To automatically place the maximum bet, select MAXIMUM BET ( -M),
then click BET or press ENTER or RETURN.

Sort Hands As High ( -H) ♦♣♥♠

This command sorts and displays your hand as its best high hand rank. It is most
useful when you’re playing a high-low game and you want to determine your best
chance of improving or winning.

Sort Hands As Low ( -L) ♦♣♥♠

This command evaluates and sorts your hand as its best low hand rank. It is most
useful when you’re playing a low or high-low game and you want to determine the
best way to improve or win.

Unsort Hands ( -U) ♦♣♥♠

This command returns your hand to its unsorted order. Usually this is the order in
which your cards were originally dealt.
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Leave Table / Return to Table ( -T) ♦♣♥♠

If you want to sit out and just watch the action, you can leave the table. Your face
icon leaves the top player monitor, but your seat is reserved for you. The game
continues without you.

• To leave the table, select LEAVE TABLE ( -T) or click your player

monitor. To return to the table, press -T again.

THE STATISTICS

MENU
Card memory and hand analysis are important skills in poker. It’s easy to stay
aware of the cards in your hand, but a good player keeps track of all the face-up
cards on the table. An exceptional player also remembers the cards that were
once visible but are no longer on the table. Each computer player in PowerPOKER
has an independent card memory  —  computer players can’t see your hand. Only
you know what your hole cards are; this information can be very useful when
estimating your chances of improving your hand or when assessing the probable
holdings of your opponents.
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Since we can’t all be expert poker players, the features in the Statistics menu
enable you to analyze the strength of your hand based on your known cards, as
well as keeping track of each player’s relative wins and losses to date.

Show Hand Analysis ( -A) ♦♣♥♠

The SHOW HAND ANALYSIS command opens the Hand Analysis window and
generates a report. When you are an active player, the Hand Analysis option
performs three types of calculations depending on the stage of the game. You can
check it periodically, or leave the window open for continual analysis.

The Hand Analysis window always displays the number of cards to come and your
hand’s historical chance of being the best (see the Show Hand Strengths
command). Until you receive your last card, it reports your chances of improving
with the addition of one or more unknown cards. The poker hands you can
possibly make are listed, along with your odds of making them.

After you receive your last card, the Hand Analysis window reports your chances
of beating the other hands on the table, which may be partially visible. The poker
hands you can possibly face are listed, along with the odds that an opponent
might hold them.

WHAT IF?
When it’s your turn to draw or pass cards, PowerPOKER can perform a “what-if “
analysis. The Hand Analysis window calculates your chances of improving your
hand by replacing the selected cards before you commit to a decision.



• To begin the analysis, select the cards you want to replace and choose the
SHOW HAND ANALYSIS command (before you click D R A W or P A S S) .

NOTE: Analysis may take a considerable amount of
time when two or more unknown cards are involved;
you may wish to open the window only when needed.

All the cards in the deck are displayed, including any jokers. You’ll see your
unknown cards highlighted in cyclic combinations as they are plugged into your
existing hand or your opponents’ hands. (Your known cards are skipped.)
Counters for the number of chances and hits (favorable tests) are updated
continuously. In high-low games, each way (high or low) is tested
simultaneously. The percentage of hits is also calculated and displayed in a
graphic thermometer. On color monitors, the thermometer changes color
according to how hot (favorable) the odds are: blue for cold (20%), green for cool
(40%), yellow for moderate (60%), orange for warm (80%) and red for hot
(100%).

• To stop the Hand Analysis, type a command-period ( -.).
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Show Hand Strengths ( -E) ♦♣♥♠

The Show Hand Strengths command displays relevant historical statistics for the
current game. The data presented depends on the number of players originally
dealt, the current stage of the game, and whether the game is played high, low, or
high-low. 

Displayed from left to right are each legal hand, how many games it’s been the
best in, its frequency percentage of being best, and most importantly, its overall
historical chance of being best. (The CHANCE OF WINNING statistic is also known
as the hand strength. A hand strength of 100% is a hand that has never lost, while
a 0% hand has never won.)

N O T E : These hand strength values reflect the poker hand
rank only. Since in 5-Card Stud a pair of kings is a much
stronger hand than a pair of twos, the hand strength data
must be interpolated to account for the weight of the card
ranks within the poker hand. This interpolated value is
displayed as a c a p t i o n in the lower right corner of each
player monitor.
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Show Standings ( -S) ♦♣♥♠

The Show Standings command opens the Standings chart window. 

This graph shows each player’s net gain or loss over the last 50 hands played, and
is updated after each showdown.

Reset Hand Strengths ♦♣♥♠

This command resets the Hand Strengths database stored in the currently open
game file. It’s a good idea to do this after changing any game rule that affects the
relative strengths of best hands at any stage of the game.

Your computer opponents rely on the hand strength data to learn how to play any
game you open or create. If there are not enough statistics available, the simulated
players will just play along for the first 10 hands dealt, until they catch on. During
this learning curve, they bet only when necessary to open a betting interval. They
may call your bets, but they won’t raise.

Reset Standings ♦♣♥♠

This command resets the Standings data stored in the House Rules file, and
equalizes all players’ stakes. The number of hands played and each player’s net
gain or loss are set to zero. The graph is not redrawn until at least one game has
been played. If a game is not underway, RESET STANDINGS also resets each
player’s stake to the buy-in amount.
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THE OPTIONS MENU
The Options menu lets you customize the playing area, deck, sound, speech, and
animation, and offers several helpful features you can toggle on and off according
to preference. Experiment with the settings until you find the combination that
works best for you.

Peek at My Hand ♦♣♥♠

This option flips your hole cards face-up (only you can see them). Unlike the
mouse-click peeking method (described in the Table Window section, page xxx),
this option leaves your cards in a visible position until you turn the feature off by
re-selecting PEEK AT MY HAND. Your cards are sorted as originally dealt, and
your chips are always visible under this option. (You can still click on any of your
cards, face-up or down, to see them evaluated and sorted.)
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Peek at Other Hands ♦♣♥♠

Sometimes it’s fun and educational to be able to see other players’ hole cards and
watch how other players play their hands. When PEEK AT OTHER HANDS is
checked, all the hole cards on the table are lifted and flipped face-up as soon as
you fold. As long as you are in the pot, you can peek only at your own cards.
However, you can always click on other players’ face-up cards or the exposed
cards in the widow to sort and evaluate them. (This option is not available during
network play.)

Help Me Select Cards ♦♣♥♠

When this option is checked and it’s your turn to draw, roll, pass or discard,
PowerPOKER makes a recommendation by pre-selecting some of your cards. (If
no cards are highlighted, then you probably have a pat hand (i.e., a hand worth
keeping).

• To accept PowerPOKER’s choices, press ENTER or RETURN or click the
Special Action (Draw, Roll, Pass, Discard) button.

• If you don’t agree with the defaults, click the highlighted cards to de-
select them and select the cards of your choice, then press ENTER or
RETURN or click the Special Action button.

QuickTime Players ♦♣♥♠

This option turns the “Not-Ready-For-QuickTime Players” on or off. When this
option is ON, you and your opponents come alive with short video clips of real
poker players, complete with their actual recorded voices.

N O T E : To use the QuickTime players, Apple’s QuickTime
system extension must be installed. The Movies folder
(and all enclosed folders and files) must be located in your
PowerPOKER folder. Game play may seem slower with the
QuickTime Players actively reacting to game situations.
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Dealer’s Speech ♦♣♥♠

When DEALER’S SPEECH is ON, you’ll hear a lively play-by-play description of the
action. PowerPOKER supports two types of speech output:

Digitized speech is available on System 6.0.7 or higher. The Speech file must
be located inside your Sounds subfolder.

Synthesized speech is supported when Apple’s PlainTalk™ Text-To-Speech files
are installed (see the Speech Settings command). When Synthesized speech is
active, the game can continue animating or playing even as the dealer is
speaking (unlike Digitized speech), and you’ll hear more narration. PlainTalk is
available from Apple.

Sound Effects ♦♣♥♠

When this option is checked, the game’s sound effects are ON. You’ll hear the
shuffle of the cards and the clink of the chips, to name a few. The Effects file must
be located in your Sounds subfolder.

NOTE: P o w e r P O K E R runs noticeably faster with Sound
Effects OFF.

Speech Settings… ♦♣♥♠

The Voice dialog box lets you choose the dealer’s voice.

A Click this button to use the standard Dealer Speech (default).

B Click this button to use PlainTalk
™

voices. Choose from the available
voices. This option is available only when Apple’s PlainTalk™ Text-To-
Speech files are properly installed on your system, and it supports
Apple’s Speech Manager with MacInTalk II files as well. 

A

B
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Sound Volume ( -0 thru -7) ♦♣♥♠

This submenu controls the volume of your Macintosh’s built-in speaker. The
levels 0 (low) through 7 (high) correspond to the System’s SOUND control panel.

Animation… ♦♣♥♠

Use this dialog box to customize PowerPOKER’s animation speed and quality to
your preference.

A Adjust the speed of PowerPOKER’s animation, or turn it off. When
animation is OFF, objects flash into place without appearing to move.

TIP: If you have an older computer, you’ll probably
want to turn the animation OFF.

B Check this box to enable FAST PLAY-OUT, which temporarily turns
animation OFF when you fold, thereby speeding up the game (useful if
you are anxious to start the next hand). Animation resumes at the
previous speed upon the next deal, if you are dealt in. (This option is not
available during network play.)

C Check this box to enable SMOOTH ACCELERATION & DECELERATION.
When this option is ON, objects speed up and slow down naturally when
they move. This feature enhances the realism of PowerPOKER, but also
slows the action on slower Macintoshes.

D Check this box to see the shuffle before each deal; the deck shuffles 2 to
3 times. Uncheck this box to turn card-shuffling animation OFF; the deal
begins immediately after you begin play. 

A

B

C

D
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Color Cards… ♦♣♥♠

This option lets you customize the deck to your preference.

A Choose between Jumbo and Standard card style. The Jumbo style may be
easier to read than the Standard faces (shown above). (On black and white
systems, this option is not available, and cards appear in Jumbo style.)

B Use these pop-up menus to choose the foreground and background
colors on the back of the cards.

The Table… ♦♣♥♠

Use this dialog box to customize the playing area to your preference

.

A

B

C

A

B



A Specify the number of seats available for opposing players (minimum:
3). 9” monitors can accommodate up to 7 seats, while 13” and larger
monitors can seat up to 10. The Table Window resizes itself accordingly.
You can add seats while a game is in progress, but you can’t eliminate
active players until the hand is over.

N O T E : In games requiring that over seven cards be
dealt, monitors smaller than 13” may not display
additional cards, and seats 8 through 10 may not
appear until you enlarge the window by dragging the
lower-right corner.

B Check this box to allow your computer opponents the freedom to enter
and leave the game as they wish. If you want to play against a constant
number of players, leave this option unchecked.

C Choose a WOODGRAIN or METALLIC playing surface, and OPAQUE or
TRANSLUCENT shadows. (The Table Trim and Shadows options are
enabled only when your monitor is displaying at least 256 colors or
grayscale. The Woodgrain Table Trim option requires that the Woodgrain
file be in your Options subfolder.)
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GLOSSARY
A ♦♣♥♠

ACE POTS - Draw poker in which no player may open without a pair of aces or
better. See Jack the Pot (also Kingpots, Queenpots).

ACES UP - A hand which includes two pair with one of them being aces.

ANTE - The minimum bet placed in the pot before a hand is dealt. The amount is
usually determined by the dealer. 

B ♦♣♥♠

BET - Any wager placed on the outcome of the game.

BET BLIND - Betting without any cards being up, or without looking at the hand.

BET THE POT - A bet which matches the amount in the pot at any given time.

BET OR DROP - Usually a form of draw poker, this is a game in which a player
may not check.

BIG BOBTAIL - Also known as a double-ended or outside straight flush. Four
cards in sequence that can be filled to a straight flush by the draw of either the
next lowest or the next highest card in the sequence.

BIG DOG - A hand with an ace-high and nine-low but with no pairs.

BIG TIGER - Also known as a Big Cat, this hand has King-high and eight-low with
no pairs.

BLIND - A mandatory bet or ante typically made before the cards are dealt.

BLIND AND STRADDLE - A variation of draw poker. The first player must open
regardless of his hand. The second player must raise blind. The third player may
also have to raise. 

BLUFF - A bet on a hand that the player believes is not strong enough to win.

BOAT - Another term for a full house. Also known as a full boat.
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BUMP - Another word for raise.

BUY-IN - See Stack.

C ♦♣♥♠

CALL - Bet the same amount as the last bet. Also known as see or stay.

CHECK - Remaining in a hand without betting. A player can only check if he is the
first bettor, or if everyone betting before him has checked. Once someone bets,
the other players have to call, raise, or fold.

CHECK AND RAISE - The practice of checking on the first bet of a round, and then
raising after another player has bet in the same round.

CHIPS - The tokens or pieces used, instead of money, to bet.

CLOSED POKER - In a closed game, all cards but the player’s own are hidden. The
most common closed game is draw poker.

D ♦♣♥♠

DEALER - The player who is currently distributing the cards in preparation of play. 

DEALER’S CHOICE - When the dealer has the right to name the type of game to be
played during the ensuing deal.

DECK - All the playing cards with which a game is played; also called a pack.

DEUCE - The two in a deck of cards.

DEUCES WILD - Games where all four deuces are wild.

DISCARD - Cards removed from play for the duration of the hand, usually
exchanged for other cards in the deck, such as in a game of draw or substitution.

DOWN CARD - A card dealt face down. A hole card is always dealt down.

DRAW POKER - The most common form of poker. Players are dealt all down
cards, and after a round of betting, are allowed to discard some cards and replace
them with others from the deck.

DROP - To withdraw from a game, also known as fold.
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F ♦♣♥♠

FACE CARDS - Jacks, Queens, and Kings. The Ace is not a face card.

FIVE OF A KIND - The highest ranking hand, Five of a Kind is not possible in a
natural game, but only when wild cards are available.

FLUSH - A hand with all cards of the same suit. A flush beats a straight but loses
to a full house.

FOLD - To withdraw from the game: see Drop.

FOUR OF A KIND - Four cards of the same denomination in a hand. This hand
beats a full house, but loses to a straight flush.

FOUR-FLUSH - Four cards of the same suit. 

FOUR-STRAIGHT - Four cards in sequence. 

FREEZEOUT - When a player must drop out of a game because his original stake
is exhausted.

FULL HOUSE - A hand made up of three of a kind and a pair. 

H ♦♣♥♠

HAND - 1) The cards dealt to a player during the course of a game, e., what the
player has in his hand. 2) A single contained game consisting of a specified
number of cards and betting rounds.

HEAD-TO-HEAD - Two players engaged in a game, one against the other.

HIGH-LOW - The highest and lowest hands split the pot.

HIGH - Poker Games in which the highest hand wins, as opposed to Lowball,
where the lowest hand wins. Most games are highball unless specifically
designated lowball.

HOLE CARDS - Cards dealt face-down during stud poker, usually the first and last
cards.

HOUSE RULES - In a casino or gambling establishment, house rules are the basic
laws and customs governing game play. 
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I ♦♣♥♠

INSIDE STRAIGHT - When a player has four cards all leading to a straight, but the
fifth card that he needs is a card in the middle of the sequence. For example, a
hand of 4, 5, 6, and 8 requires the player to “draw to an inside straight.”

J ♦♣♥♠

JACKS OR BETTER - To open, players must have a pair of jacks or better.

JACK THE POT - Ante again to a jackpot not opened to on a previous deal. For
example, if jacks or better are needed to open and no one in the hand can open,
then the cards are gathered and a new hand dealt, but all the players must re-ante,
or sweeten the pot. 

JOKER - One or two extra cards that are included in a deck: sometimes used as a
wild cards.

JOKERS WILD - Any game in which the joker(s) serve as wild cards.

K ♦♣♥♠

KICKER - The card that determines the winner of a tie (e.g. A-K-7 beats A-K-6 — 7
is the kicker).

L ♦♣♥♠

LIMIT - The maximum amount by which a player may bet or raise.

LITTLE BOBTAIL - Three cards in sequence that can be filled to a Big Bobtail by
the draw of either the next lowest or the next highest card in the sequence.

LITTLE DOG - A hand consisting of seven-high and deuce-low but no pair.

LITTLE TIGER (or LITTLE CAT)- A hand consisting of eight-high and three-low but
no pair.

LOW - The worst or lowest hand, not counting straights or flushes.

LOWBALL - The reversal of a standard highball game; here the lowest hand wins
the pot.
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M ♦♣♥♠

MATCH THE POT - Bet the equivalent of the pot.

N ♦♣♥♠

NATURAL - A game or hand that stands without the help of wild cards.

O ♦♣♥♠

ON THE BOARD - Cards that are dealt face-up or are showing.

OPEN - 1) Make the first bet. 2) Opposite of closed, cards dealt face-up.

OPENERS - The hand needed to open the betting in a game (e.g., jacks or better
to open).

OUTSIDE STRAIGHT - Four cards in sequence leading to a straight, but needing
either a low card or high card on the end to complete the straight (e.g., 4, 5, 6, 7.
Drawing either a 3 or an 8 would complete the straight. See also Four Straight).

P ♦♣♥♠

PAIR - Two of a kind (e.g., two deuces, two kings, etc.).

PASS - When a player declines to bet, he or she passes. The player doesn’t fold,
but reserves the right to call and raise, and remains in the game. This usually
occurs in draw poker.

PASS AND OUT - This negates the pass rule which allows a player to remain in
the game. The player must drop out of the hand once they have passed.

POKER FACE - Keeping one’s emotions hidden. When a player has a good poker
face, other players are unable to determine what cards the player is holding by the
way he looks or behaves.

POT - The pool of money made up of the antes and bets. The pot is also known as
the kitty.

R ♦♣♥♠

RAISE - To put more chips in the pot than is necessary to call the previous bet.
Other players must now meet the new additional amount or fold.
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REDEAL - The same dealer redistributes the cards, usually after the deal is passed
out.

ROYAL FLUSH - The best natural hand in poker. A straight flush, ace high (10, J,
Q, K, A). The only hand that beats a royal flush is five of a kind, which is only
possible in game with wild cards.

S ♦♣♥♠

SANDBAGGING - See Check and Raise.

SEE - Meet a bet; see call.

SHOWDOWN - The showing of all active hands to determine the winner of the pot.

SHOWING - The cards that are face up (a.k.a. On the Board). In stud poker, the
player with the best cards showing usually opens the betting.

SIT OUT - To refrain from playing a hand, but remain in the game. Players
typically sit out to save their antes in games they don’t know.

SKIP STRAIGHT - A special straight consisting of a skipped sequence of cards,
both odd and even, e.g., 3-5-7-9-J or 2-4-6-8-10. Also known as a dutch straight
or a kangaroo straight.

SPLITTING OPENERS - In draw poker, discarding part of the combination that
allowed the player to open, in the hopes of improving the hand.

STACK - Each player’s pile of chips; the amount of chips each player receives to
start a game.

STAKE - 1) The amount of money allowed to bet at one time, a.k.a. the limit. 2)
The total amount of money a player brings to a game.

STAND PAT - In draw poker, when a player chooses not to discard and draw more
cards.

STRADDLE - To raise the previous player’s blind bet in the first round. See Blind
and Straddle.

STRAIGHT - A complete sequence of at least five cards in numerical or ranking
order. 2-3-4-5-6, or 10-J-Q-K-A.

STRAIGHT FLUSH - A straight which is comprised of cards of the same suit.



70

STUD POKER - A type of poker in which the dealer deals a few cards down and
the remainder of the cards up with a round of betting after each up card. Stud
poker can be five, six, seven, or eight card, and in the six, seven, and eight card
games, the final card is typically dealt down.

SUIT - Any one of the four sets of thirteen cards which make up a standard deck.
The four suits are: clubs ♣, diamonds ♦, hearts ♥, and spades ♠.

SWEETEN - See Jack the Pot.

T ♦♣♥♠

TABLE STAKES - A rule that allows players to buy chips only between hands.

TAP OUT - When player bets the full amount of chips in front of him, the player is
said to have tapped out.

THREE OF A KIND - Three cards of the same rank, as in three kings. Three of a
kind beats two pair but is beaten by a straight.

TWO PAIRS - A hand consisting of a pair of one kind, a pair of another, and a
single, unmatched card. Two pairs beats one pair, but is beaten by three of a kind.

U ♦♣♥♠

UP - A term used to designate which of two pairs, in a two pair hand, is highest. If
a player has the Dead Man’s Hand (aces and eights), then aces would be “up”.

UP-CARD - In stud poker, any card dealt face up.

W ♦♣♥♠

WIDOW - Extra cards dealt to a shared hand which can be used by all players.

WILD - A card, determined by the game rules, which can become any card the
player chooses. In a wild card game, five of a kind is possible.
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TECHNICAL SUPPORT
If you have questions about the program, our Technical Support Department can
help. If your question isn’t urgent, please write to us at: 
Electronic Arts Technical Support
PO. Box 7578
San Mateo, CA 94403-7578
Please be sure to include the following information in your letter: 

• Product name
• Type of computer you own
• Amount of and configuration of memory. 
• Any additional system information (like type and make of monitor, video

card, printer, modem etc.)
• Type of operating system or DOS version number
• Description of the problem you’re having

If you need to talk to someone immediately, call us at (415) 572-2787 Monday
though Friday between 8:30 am and 4:30 pm, Pacific Time. Please have the above
information ready when you call. This will help us answer your question in the
shortest possible time. 
If you live outside of the United States, you can contact one of our other offices.
In the United Kingdom, contact: 
Electronic Arts Pty. Limited
PO. Box 835
Slough SL3 8XU, UK.
Phone (753) 546465.
In Australia and New Zealand, contact:
Electronic Arts
PO. Box 432
Southport Qld 4215
Australia.

72



73

Within Australia call:
Phone: (075) 711 811
Within New Zealand call:
Phone: +61 75 711 811
between 9am-5pm Eastern Standard Time

LIMITED WARRANTY

Electronic Arts (“EA”) warrants to the original purchaser of the computer
software product, for a period of ninety (90) days from the date of original
purchase (the “Warranty Period”), that under normal use, the magnetic media
and the user documentation are free from defects in materials and workmanship.
WARRANTY CLAIMS

To make a warranty claim under this limited warranty, please return the product
to the point of purchase, accompanied by proof of purchase, your name, your
return address, and a statement of the defect. OR send the disk(s) to us at the
above address within 90 days of purchase. Include a copy of the dated purchase
receipt, your name, your return address, and a statement of the defect. EA or its
authorized dealer will, at our option, repair or replace the product and return it to
you (postage prepaid) or issue you with a credit equal to the purchase price. 
To replace defective media after the 90-day warranty period has expired, send the
original disk(s) to the above address. Enclose a statement of the defect, your
name, your return address, and a check or money order for $7.50.
The foregoing states the purchaser’s sole and exclusive remedy for any breach of
warranty with respect to the software product.
LIMITATIONS

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES AND NO OTHER
REPRESENTATIONS OR CLAIMS OF ANY NATURE SHALL BE BINDING ON OR
OBLIGATE ELECTRONIC ARTS. ANY IMPLIED WARRANTIES APPLICABLE TO
THIS SOFTWARE PRODUCT, INCLUDING WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED TO THE NINETY
(90) DAY PERIOD DESCRIBED ABOVE. IN NO EVENT WILL ELECTRONIC ARTS
BE LIABLE FOR ANY SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
RESULTING FROM POSSESSION, USE, OR MALFUNCTION OF THIS
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ELECTRONIC ARTS SOFTWARE PRODUCT. 
Some states do not allow limitations as to how long an implied warranty lasts
and/or exclusions or limitations of incidental or consequential damages so the
above limitations and/or exclusions of liability may not apply to you. This
warranty gives you specific rights, and you may also have other rights which vary
from state to state. 

NOTICE

ELECTRONIC ARTS RESERVES THE RIGHT TO MAKE IMPROVEMENTS IN THE
PRODUCT DESCRIBED IN THIS MANUAL AT ANY TIME AND WITHOUT NOTICE.
THIS MANUAL, AND THE SOFTWARE DESCRIBED IN THIS MANUAL, IS
COPYRIGHTED. ALL RIGHTS ARE RESERVED. NO PART OF THIS MANUAL OR
THE DESCRIBED SOFTWARE MAY BE COPIED, REPRODUCED, TRANSLATED,
OR REDUCED TO ANY ELECTRONIC MEDIUM OR MACHINE-READABLE FORM
WITHOUT THE PRIOR WRITTEN CONSENT OF ELECTRONIC ARTS, P. O. BOX
7578, SAN MATEO, CALIFORNIA 94403-7578, ATTN: CUSTOMER SUPPORT.

MANUAL © 1994 ELECTRONIC ARTS. ALL RIGHTS RESERVED. PORTIONS OF
MANUAL © 1994 TODD OUZTS

SOFTWARE © 1986, 1994 TODD OUZTS

ALL RIGHTS RESERVED.

PowerPOKER™ is a trademark of Electronic Arts

Scenario Software™ is a trademark of Todd L. Ouzts.

Apple®, LaserWriter® and Macintosh® are registered trademarks of Apple Computer, Inc.

QuickTime™, MultiFinder™, AppleTalk™, and PlainTalk™ are trademarks of Apple
Computer, Inc.

Other brand and product names are trademarks or registered trademarks of their
respective holders.
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KEY COMMANDS
Open Game -O
Close Window -W
Quit -Q

Show House Rules -J
Show Game Rules -G

Pause/Play -P

Check -K
Call -C
Bet -B
Raise -R
Draw, Roll, Pass, 
Discard, Arrange -D
Fold -F

Minimum Bet -N
Maximum Bet -M

Sort Hands as High -H
Sort Hands as Low -L
Unsort Hands -U
Leave/Return to Table -T

Show Hand Analysis -A
Show Hand Strengths -E
Show Standings -S

Sound Volume -0 - 7

NOTICE

ELECTRONIC ARTS RESERVES THE RIGHT TO MAKE 
IMPROVEMENTS IN THE PRODUCT DESCRIBED IN THIS MANUAL AT ANY TIME

AND WITHOUT NOTICE.

THIS MANUAL, AND THE SOFTWARE DESCRIBED IN THIS MANUAL, IS COPY-
RIGHTED. ALL RIGHTS ARE RESERVED. NO PART OF THIS MANUAL OR THE
DESCRIBED SOFTWARE MAY BE COPIED, REPRODUCED, TRANSLATED, OR

REDUCED TO ANY ELECTRONIC MEDIUM OR MACHINE-READABLE FORM WITH-
OUT THE PRIOR WRITTEN CONSENT OF ELECTRONIC ARTS, P. O. BOX 7578, SAN

MATEO, CALIFORNIA 
94403-7578, ATTN: CUSTOMER SUPPORT.

MANUAL © 1994 ELECTRONIC ARTS. ALL RIGHTS RESERVED. 
PORTIONS OF MANUAL © 1994 TODD OUZTS

SOFTWARE © 1986, 1994 TODD OUZTS
ALL RIGHTS RESERVED.



 

NOTE

This manual and the software described in it are copyrighted,
with all rights reserved. Under the copyright laws, this manual or
the software may not be copied, in whole or part, without written
consent of Electronic Arts, except in the normal use of the soft-
ware or to make a backup copy of the software. The same pro-
prietary and copyright notices must be affixed to any permitted
copies as were affixed to the original. This exception does not
allow copies to be made for others, whether or not sold, but all of
the material purchased (with all backup copies) may be sold,
given, or loaned to another person. Under the law, copying
includes translating into another language or format.

You may use the software on any computer owned by you, but
extra copies cannot be made for this purpose.
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